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GRAPHICAL USER INTERFACES (GUIs) \

Console app vs. Mobile app!

>> Enter employee name: Ryan
>> Enter employee title: Product

Manager
>> Enter hire date: 06-03-2018

Employee Management
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Android Studio is an integrated development environment (IDE)

for building Android apps

Download and install Android Studio here

Installing Android Studio includes

Android SDK (Software Development Kit)

Android SDK tools and platform tools (for debugging & testing)
A system image for the Android emulator

JDK

~\



https://developer.android.com/studio/install?gclid=CjwKCAiA85efBhBbEiwAD7oLQP1gPymuYO2RpfTensEKBoeTsH_65H-Q8ccnxFaxv03W5Tpj3a4H8RoCQmwQAvD_BwE&gclsrc=aw.ds

HELLO, ANDROID STUDIO! \

In Android Studio, create a new project

Select “Phone and Tablet” template - next

Select “Empty Views Activity” (different from “No Activity”) -
next

Package name: edu.utsa.cs3443 .projectName - next

Language: Java - next

Minimum SDK: Android 8 (Oreo)

Finish - Finish

Android Studio may need to install several things if this is

your first project - be patient and do not close the IDE until

it is finished!

\
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- WOICOME 10 ANdIOWa Studio

Welcome to Android Studio

L EoN New Project
Android Studio -
A P
irafe | 2022.3.1
Qe 02z A Grate 207231 Templates
. . Phone and Tablet
RS Welcome to Android Studio p— ——
Plugins Create a new project to start from scratch. Plugins Television .
Leam Open existing project from disk or version control. . Asfomaiive
No Activity Empty Activity Basic Views Activity

+

v

New Project Open Get from VCS

More Actions v - -

Bottom Navigation Views Activity Empty Views Activity Navigation Drawer Views Activity

R C

cancel | | previous | ([EEEE | rinish

o o L % L ° J
[ Welcome to Android Studio [  wy - java [My_ tion.app.main] o )
ece New Project [ My Application v [ mapp v || QricioaPizz v | B #G o~ R0 Qe
S :cgr':i‘dzggc:ic: g Andoid v T @ — | @ activity_mainxml < 54 MainActivity java i Assistant What's New o — g
Empty Views Activity i —_— el =
£ v mapp 1 package edu.utsa.cs3443.nyapplication; \ . H
» > i manifests B What's New in Giraffe =
Projects Creates a new empty activity 3 g
N v W 3 import ... ) ) g
Customize 5 [ edu.utsa.cs3443.myapplication ) “This panel describes some of the new features and behavior e
Name My Application H € MainActivity ; I changes included in this update. b
Plugins 3 > [ edu.utsa.cs3443.myapplication (androic i i g i
. g yapplistion public class MainActivity extends AppCompatActivity { 10 OPen this panel again later, select Help > What's New in g
Loan Package name edu.utsa.cs3443.myapplication 2 > [ edu.utsa.cs3443.myapplication (test) Android Studio from the main menu. H
& > bzres 2
a Read in a browser e
> no usages H
Save location dSam/Documents/UTSA/CS3443_application_programming/fall_2023/MyApplication # Gradla Scripts ) - &
protected void onCreate(Bundle savedInstanceState) Use Live Edit to update composables in real time
Language Java v i . =
1 super. onCreate (savedInstancestate) ;- Live Edit s a feature in Android Studio Giraffe that lets you update | &
12 setContentView(R.layout.activity_main); composables in emulators and physical devices in real time. Edit | &
Minimur SDK API 24 ("Nougat"; Android 7.0) v 3 } composables and see the Ul changes on the running device ";
" without re-deploying your app. This functionality minimizes
© Your app will run on approximately 95.4% of devices. 0 context switches between writing and building your app, letting s
e e H you focus on writing code longer without interruption. To try Live o
] Edit, use AGP 8.1 or higher and Compose 1.3.0 or higher. g
2 s
Build configuration language > | Kotlin DSL (build.gradle kts) [Rec v &
&
. z
2 3
o g
L H
i 0
s Learr @ Clang-Tidy has been updated g
2 17 new checks have been added 5
H New H
‘ 2 Review z
Cancel | Previous et (S ANdroia STGIO Girae Lanary £ INIToauces SUppor 1or e new ul
P Version Control TODO @ Problems Terminal ) Services  App Quality Insights. & App Inspection ogcat 4 Build 2 Profiler I Layout Inspector
] v o | (1 Gradle sync finished in 2 m 37 540 ms (moments ago) de> || Showall(2) 1 LF UTF-8 4spaces W @ ®
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[ O ] My Application - MainActivity.java [My_Application-app=mein} — = — — _I il
| |
MyApplication = app = src = main = java = edu = utsa cs3443 = myapplication = ‘€ MainActivity v sapp v [LPixel6API32 v | P { & N v HSI X 1 Q %
§ # Android D =T = B/ — g activity_main.xml 3 MainActivity.java i = d PO
E v 17 app 1 package edu.utsa.cs3443.myapplication; §
B > [ manifests 2 g
. v [ java import ... g
“g} v [ edu.utsa.cs3443.myapplication . =
5 ‘ '
g ainActivity - : ——— : o
g edu.utsa.cs3443.myapplication (androic e el Wainnsinie B shcivity 4 o
5 ety ublic class Mai ivity extends ompatActivi
é 0 edu.utsa.cs3443.myapplication (test) P y ppLomp y : §
& v Dzres | %
de drawable no usages : 2
o «Q
v [0 layout @0verride | S
& activity_main.xml 10 protected void onCreate(Bundle savedInstanceState) { - =
> [ mipmap 11 super.onCreate(savedInstanceState); ;
[
> [ values 12 setContentView(R.layout.activity_main); g
> L xml 13 } 5
> @ Gradle Scripts 14 }
) 4
2 @
g
o ()
s FEETmTEEEEEEEEET 1 r-=—=-=-=-======== 1
| . . | | . . | 1
., , Projecttoolwindow | ,  Editor tool window | &
pd &
- - S - 3
: .
[o] «
&
| =
&
2
8 0
3 o
5 2
— (2]
S (1]
@ m
a 3
Q
I Version Control i= TODO @ Problems Terminal {3 Services € App Quality Insights 4 App Inspection = Logcat 4 Build 7 Profiler I Layout Inspector
LIL] Gradle sync finished in 2 m 37 s 540 ms (a minute ago) Indexing 'Gradle Script dependencies' added files * |l Showall(2) 11 LF UTF-8 4spaces Tn @ H 1
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HELLO, ANDROID STUDIO!

Layout Editor

- drag and drop views in the Design mode

- view the xml code by clicking the Code button in the top left

Y My Application - activity_main.xml [My_Application.app.main] A
MyApplication app src  main res layout g activity_main.xml A app ¥  NoDevices v P E-1 LR 1 a0 Q&6
] Android ¥ (2] = & — &, activity_main.xml © MainActivity.java HI
£ s
I app Split M Design &
- > [ manifests 3
<?xml version="1.0" encoding="utf-8"?> v gl activity_main.xmi g
v W java 2 c 3
n € < : g : . 3 H
5 « Ba edu.utsa.cs3443.myapplication <androidx.constraintlayout.widget.Constraintlayout xulns:androi & o\ o o
g & MainActivity xmlns:app="http://schemas.android.com/apk/res-auto" &
= > Iu edu.utsa.cs3443.myapplication (andr xmlns:tools="http://schemas.android.com/tools"
B > [m edu.utsa.cs3443.myapplication (te android:layout_width="match_parent"
& v Bzres android:layout_height="match_parent"
L3 > [ drawable tools:context=".MainActivity">
v layout
<TextView
¥ i 1
mipmap android:layout_width="wrap_content" z
> n values : : &
il android:layout_height="wrap_content" 2
g s » T ES
> P Gredie Scipts android:text="Hello World!
o app:layout_constraintBottom_toBottom0f="parent" -
2 app:layout_constraintEnd_toEnd0f="parent" 2
B a
& app:layout_constraintStart_toStartOf="parent" &
- app:layout_constraintTop_toTopOf="parent" /> e
=]
g </androidx.constraintlayout.widget.ConstraintLayout> 3
£ 5
& =
H
n & g
2
5 2 o
5 £
g s »
E] 2 H
& B H
= g
b Version Control i= TODO © Problems B Terminal © services % App Quality Insights & App Inspection = Logcat 4 Build 2 Profiler I Layout Inspector
\[J* daemon started successfully (40 minutes ago) 11 LF UTF-8 4spaces n @ ®




HELLO, ANDROID STUDIO! \
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Resource: a piece of your app that is = AT
kst Androi v = = -
1 1 1 g v mapp
not code (e.g. image files, audio, XML) & " "*
Layout . DeflneS a Set Of UI ObJ eCtS and % v JaVaedu.utsa.cs3443.myapp|ication
. ' o § € MainActivity o |
the ObJ ects pOS:Lt ions on the screen : > edu.utsa.cs3443.myappl!catfon (androic
§ > edu.utsa.cs3443.myapplication (test)
. . . . & java (generated)
View: UI objects (View is a superclass - BT
> drawable
of all UI components) v Ealayout
e activity_main.xml
Inflate: parse an XML layout resource » Basiice
> xml

and convert it to a hierarchy of View

res (generated)
> @ Gradle Scripts

‘tructure

objects
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Activity: a class in the Android SDK which represents an entry point to into your

app and is responsible for managing user interactions with a screen of information

Name your Activity class: SomeNameActivity. java

Name your layout file:

MyApplication = app = src = main  java edu = utsa  cs3443 = myapplication =€ MainActivity - app v P »
] Android v D = = & — g activity_mainxml i MainActivity.java
E v app package edu.utsa.cs3443.myapplication;
L] > manifests
N v Wjava import ...
g -
2
b no usages
g S e o blic class MainActivity extends AppCompatActivity {
s ot u
§ edu.utsa.cs3443.myapplication (test) P ¥ ppLomp ¥
-4 res
7S > Bu drawable no usages
lavout @Override

I 2 activity_main.xml l protected void onCreate(Bundle savedInstanceState) {

 SrrterrraD” super.onCreate(savedInstanceState);

> values setContentView(R.layout.activity_main);

xml }
> @ Gradle Scripts }
2
7]
H
5
E
3
8
@
n
2
=
K]
S
2
@
=
2 Version Control ~ := TODO @ Problems B Terminal @ Services € App Quality Insights & App Inspection = Logcat 4 Build ¢z, Profiler

]

activity_some_name.xml

N -

I3 Layout Inspector

SuoneaynoN P
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In this example:
MainActivity.java
and

activity_main.xml
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MainActivity.java (default template)

onCreate() is called when an instance of the activity subclass is

created

setContentView() assigns this activity the UI it manages; it

inflates the layout & puts it on the screen, instantiating all views in

the layout file as defined by their attributes

package edu.utsa.cs3443.hello_world;

import androidx.appcompat.app.AppCompatActivity;
import android.os.Bundle;

public class MainActivity extends AppCompatActivity {

protected void onCreate(Bundle savedInstanceState) {
super.onCreate(savedInstanceState);
setContentView(R.layout.activity_main);
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ANDROID SDK

~\

Immediately after installing Android Studio for the first time it
is likely that only the latest released version of the Android SDK
has been installed.

To install older versions of the Android SDK simply select the
checkboxes corresponding to the versions and click on the Apply
button.

This task can be performed by clicking on the More Actions link
within the welcome dialog or by clicking the Preferences menu
option, then selecting the SDK Manager option from the drop-down
menu,

- select Android Oreo (8.9)




¥ Project | o

%> Resource Manager

g
@

3 Bookmarks.

¥ Build Variants.

{o]

TRy . " D r.
About Android Studio My = java [My_ app.main] e e
W) Check for Updates. edu  utsa  cs3443 = myapplication | © MainActivity v | mapp v | NoDevices v P - LR - R0 QAxe MyApplication ' app |
Preferences... & — g activity_mainxml < @ MainActivity.java N § = Ancoid + -
- - package edu.utsa.cs3443.nyapplication; v g £ app EiAppearance  Behaviod
i B > [ manifests Keymap
Hide Android Studio import ... g LY Mjava > Editor
Hide Others x ation ) v [ieduutst  piygins
Show All 2 usages o 2 O | \.sion control
ion (androl ublic class MainActivity extends AppCompatActivity { g 14 i |
: ] ; v: 2 £ il i
Quit Android Studio ation (test) | | W | P ¥ ppComp: y g £ S txeduutss ’ Build, Execution, Deployment
= & v mres ~ Languages & Frameworks
> £n drawable @avarride H > budrawabl > C/Ct+
v Bulayout T protected void onCreate(Bundle savedInstanceState) { 2 v B layout > Seremasand DIDS
@ activity_main.xml super.onCreate(savedInstanceState) ;  activi TSIk
z : o " ndroid SDI
> £ mipmap setContentView(R.layout.activity_main); = > £ mipmap!
> 2 values ¥ % > mvalud) > Kotlin
> b xml } g > b xml Markdown
> @ Gradle Scripts > @ Gradle Scripts Template Data Languages
-
° £ > Tools
H 2 Advanced Settings
&
. Kotlin Compiler
H R > Experimental
z £
e 3
o H
g 3
2 n
g
g H
o 3
] -
1 Version Control ODO  © Problems B Terminal (O Services @ App QualityInsights 4 Appnspection = Logeat 4 Build (2 Profiler T Layout Inspector P Version Control | (5
Gradle sync finished in 2 m 37 s 540 ms (45 minutes ago) 11 LF UTF-8 4spaces W @ @& \IC]_Grade sync finished in.
r
ece Preferences

MyApplication = app

g = Andod v
£ v teapp
> o manifests
v W java
& ~ I3 edu.utst
g :
5 <
3 Main,
s > bn eduuts:
2 > bneduutst
& v Bzres
“ > £ drawabl
v [n layout
& activ
> mipm:
> b values
> xml
> @ Gradle Scripts
g
&
H
g
n
H

P Version Control

0 Gradle sync finished

> Appearance & Behavior
Keymap
> Editor
Plugins
> Version Control
> Build, Execution, Deployment
+ Languages & Frameworks
> ClCH
> Schemas and DTDs
Android SDK
> Kotlin
Markdown
Template Data Languages
> Tools
Advanced Settings
Kotlin Compiler
> Experimental

L & >
Manager for the Android SDK and Tools used by the IDE
Android SDK Location:

SDK Platforms

SDK Tools ~_SDK Update Sites.

Below are the available SDK developet tools. Once installed
updates. Check "show package details
Name

[ Android SDK Build-Tools 34
NDK (Side by side)
Android SDK Command-line Tools (latest)
CMake
Android Auto API Simulators
Android Auto Desktop Head Unit Emulator

3 Android Emulator

& Android SDK Platform-Tools
Google Play APK Expansion library
Google Play Instant Development SDK
Google Play Licensing Library
Google Play services
Google Web Driver
Intel x86 Emulator Accelerator (HAXM installer)
Layout Inspector image server for API 29-30
Layout Inspector image server for AP 31-34
Layout Inspector image server for API S

|Users/HendSamjLibrary/Android/sdk

, the IDE will automatically check for
\.

display available versions of an SDK Tool

Version Status
Update Available: 34.0.0
Not Installed
Not Installed
Not Installed
Not installed
Not installed

Update Available: 32.1.14
33.0.3 Update Available: 34.0.4
1 Not installed
1.9.0 Not installed
1 Not installed
49 Not installed
2 Not installed
765 Not installed
6 Not installed
3 Not installed
3 Not installed

Hide Obsolete Packages

Cancel Apply

Edit Optimize disk space

Show Package Details

Preferences

Manager for the Android SDK and Tools used by the IDE

Android SDK Location:  /Users/HendSam/Library/Android/sdk Edit

SDK Platforms

SDK Tools  SDK Update Sites

Each Android SDK Phatform package includes the Android platform and sources pertaining to an
AP level by default. Oncegstalled, the IDE will automatically check for updates. Check "show
package details" to display idiyidual SDK components.

Name APl Level Reuis.
Android API 34 34 1
Android UpsideDownC Prev UpsideDownC: 1
Android Preview Tir 9
Android 13.0 (*Tiramisu") 33 2

Android 13.0 ("Tiramisu" 33-ext4 1
Android 13.0 (*Tiramisu") 33-ext5 1
Android 12L ("Sv2") 32 1
Android 12.0 (*S") Ell 1
Android 11.0 ("R") 30 3
Android 10.0 ("Q") 29 5
Android 9.0 (*Pie") 28 6
Android 8.1 ("Oreo") 27 3

Android 8.0 ("Oreo") 26 2
Android 7.11 (*Nougat’) 25 3
Android 7.0 ("Nougat") 24 2
Android 6.0 ("Marshmallow") 23 3
Android 5.1 ("Lollipop") 22 2
Android 5.0 (*Lollipop") 21 2

Hide Obsolete Packages

Cancel

=
g
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Joidx3 2012 T

T Layout Inspector
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Apply

Optimize disk space

Status
Not installed
Not installed
Not installed

Partially instal...

Installed
Not installed
Not installed
Not installed
Not installed
Not installed
Not installed
Not installed
Installed

Not installed
Not installed
Not installed
Not installed
Not installed

Show Package Details

“ & Layout Inspector

B 4spaces W @ B
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CREATING A VIRTUAL DEVICE \
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An Android application may be tested by installing and running
it either on a physical device or in an Android Virtual Device

(AVD) emulator environment.

As part of the standard Android Studio installation, several
emulator templates are installed allowing AVDs to be

configured for a range of different devices.

New AVDs are created and managed using the Android Virtual
Device Manager.

- Tools > Device Manager (or the (] icon)




le ieati PP i cati " N
XX My java [My_ app.main]

MyApplication = app = src ~ main  java  edu  utsa  cs3443 = myapplication = € MainActivity v [ mapp v | [LpieloaPiz2z v B & ™~ ML QR
§ = Andoid v @ E T & — Zactviymanml ¢ & MainActivityjava ila
£ v mapp package edu.utsa.cs3443.myapplication; DeviceManacen
B> o manifests 3
& [ edu.utsa.cs3443.myapplication
H MainActivity [ o
4 2 L JCAREYER SR SE N CIE, ublic class MainActivity extends AppCompatActivity { g
= > I edu.utsa.cs3443.myapplication (test) B ¥ ppConp: ¥ =
3 > [x drawable nousages 3

© Pulayout @verride ]

& activity_main.xml protected void onCreate(Bundle savedInstanceState) {

> % mipmap super.onCreate(savedInstanceState); =

> [ values 12 setContentView(R.layout.activity_main); &

> bl . } £

> @ Gradle Scripts }

° : 4
H 2
# s
")

- z
£ 2
; :
"
£ g
5 o
H g
z 2
= 3
o

P Version Control TODO @ Problems B Terminal (3 Services @ App Quality Insights & App Inspection = Logcat 4 Build ¢\ Profiler T Layout Inspector
1) Opens the device manager which manages virtual and physical devices. Indexing 'Gradle Script dependencies' added files = Showall (2) 11 LF UTF-8 4spaces m @ H|
[ My Application - activity_main.xml [My_Application.app.main]

MyApplication ) app @ © @ Virtual Device Configuration ®0L Qe
g = Android ~ o - e
e &
£ v mapp g
- - Select Hardware H
LY Wiava g
3 v I edu.ut] Actions ’
H i © Mai o
8 edutlt  choose a device definition H
H > o eduut H
E v . ) H
“ > I drawat [ Pixel6 H

o nlayout | Cotesory Name v Play Store  Size Resolution  Density H

ot Resizable (Experiment... 6.0 1080x2...  420dpi
> [n mipma 1080px =
> Cnvalues  Tablet Pixel XL 55" 1440x2...  560dpi Jarge [evice to test g
> ol atio: long |device. g
> @ Gradle Scrip  Wear OS Pixel 7 Pro B 671" 1440x3...  560dpi Density: 420dpi B
o rd
2 Desktop Pixel 7. 3 6.31" 1080x2...  420dpi 24000 @
o v Pixel 6a 3 613" 1080x2...  420dpi °
i N ©
P Automot...  Pixel 6 Pro 67" 1440x3..  560dpi c
g 5 g
2 1080x2... | 420dpi 2
H £
n 2
New Hardware Profile Import Hardware Profiles S Clone Device... s
H [
= z
H
g
? Cancel Previous Next Finish 2

& Layout Inspector
4spaces w O A

P Version Control

([0 * daemon started succe

I ioati " - A

0o My java [My_Application.app.main]
MyApplication | app = src ~ main  java  edu  utsa  cs3443  myapplication € MainActivity v [ & app ~ || NoDevices v | B #0G O~ ML Qs
g = Andoid v T & — g ectivitymainxml < A MainActivityjava i Device Manager % - g
£ v mapp package edu.utsa.cs3443.myapplication; Virtual  Physical g
B > [ manifests 2 i
v java import Create Device =~ S ? F
§ I3 edu.utsa.cs3443 myapplication ; Device & APl Siz.. Actions i
H © MainActivit
2 o I —— no usages o
g s o o ol ublic class MainActivity extends AppCompatActivity { g
8 o X
H > E eduutsa.cs3443 myapplication (test) L ¥ Bpeonp v |
g . me 2
“ > [x drawable no usages £
v B layout 9 @0verride g
& activity_main.xml protected void onCreate(Bundle savedInstanceState)
> Lx mipmap super.onCreate (savedInstanceState) ; >
N valtigs 12 setContentview(R. ayout.activity_nain); No virtual devices added. Create a virtual device to test E
> taxml . applications without owning a physical device. H
> @ Gradle Scripts ) ) Create virtual device o
o ) -
g [
H H
5 &
&
£ z
3 8
8 g
n :
H
2 a
s g
z 2
3 o
& s
I Version Control ~ i=TODO @ Problems Terminal @ Services  § App Quality Insights AppInspection = Logcat 4 Build (3, Profiler T Layout Inspector

\[0 _Gradle sync finished in 2 m 37 s 540 ms (a minute ago) Indexing ‘Gradle Script dependencies' added files s Showall (2) %1 LF UTF-8 d4spaces fa @ ® |
f 3
My Application - activity_main.xml [My_Application.app.main]

MyApplicat ® © @ Virtual Device Configuration Qs e
g = And & —
T z
a . ap| 5
N om System Image H

v H
= v *
b3 1 &
g Select a system image g
= Recommended  x86 Images  Other Images . £
i — Tiramisu H
&
h Release Name APl Level v ABI Target 2

3 J API34 & 34 x86_64 Android API 34 (Google APIs) APl Level
K Tiramisu L. 33 x86_64 Android 13.0 (Google APIs) 33 fest g
&
> svz & 32 X86_64 Android 12L (Google APIs) p— =
> men gy 31 X86_64 Android 12.0 (Google APIs) 13.0 -
g R 30 x86 Android 11.0 (Google APIs) Google Inc. e
g |
& Qi 29 x86 Android 10.0 (Google APIs) &

System Image
pie & 28 Xx86 Android 9.0 (Google APls) x86.64 B
£ Oreo & 27 x86 Android 8.1 (Google APIs) We recommend these images because they run the &
H ]
£ Oreo & 26 x86 Android 8.0 (Google APs) fastest and support Google APts 2
2 5
N ' o - e o Questions on API level? =
S See the API level distribution chart g
E © A system image must be selected to continue. (e
2
3 H
= o
? Cancel Previous Next Finish | | g
P Versio, _¢Inspector

O - dsemon s s « 0 u



MyApplicat
| = s
£ v map
- >
vm
H >
g Selecta sy
-
3 .
= Recommend
L) L — |
v [ Releasenan
API34 &
>
4 Tiramisdl]

> s s
> men g

$ R

& Qs

o pie &

2 Oreo &
£ oreo &
n

s O Asystem
2

=

b Versio,
* daemon start

(=]

My Application - activity_main.xml [My_Application.app.main]

SDK Quickfix Installation

License Agreement

Licenses
* android-sdk-arm-dbt-license
£ Google APIs Intel x86_64 Atom

Terms and Conditions.
This is the Android Software Development Kit License Agreement
. Introduction

11 The Android Software Development Kit (referred to in the License Agreement as the "SDK"
and specifically including the Android system files, packaged APIs, and Google APIs add-ons) is
licensed to you subject to the terms of the License Agreement. The License Agreement forms a
legally binding contract between you and Google i relation to your use of the SDK.

1.2 "Android" means the Android software stack for devices, as made available under the
Android Open Source Project, which is located at the following URL: https//source.android.com/,
s updated from time to time.

{134 *compatible implemetation” means any Androld device tha () complies with he Android
Compatibility Definition document, which can be found at the Android compatibility w

(i source andioi.comicompatiiit) and which may bo updated fom tme to imes and (i)
successfully passes the Android Compatibility Test Suite (CTS).

1.4 "Google" means Google Inc., a Delaware corporation with principal place of business at 1600
Amphitheatre Parkway, Mountain View, CA 94043, United States.

2. Accepting the License Agreement
Decline (© Accept

Cancel Previous Next Finish

Finish

suoneauoN B

iobeue s3100 3

>

apeio X,
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{nspector
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My Application - activity_main.xml [My_Application.app.main]

tinspector

suoneayioN B

o
£
8
£
H

wersissy

aipeio X,

uonepien 1ofen &)

1830 Buuuny 51

MyApplicat [ SDK Quickfix Installation Qg e
i
g
H SDK Component Installer
H
s >
§ 1 Selectasy Completing Requested Actions
€ VM pocommeny SDKPath: JUsersiHendSamLibrary/Androidjsdk I
a > ————— Packages to install: - Google APIs Intel x86_64 Atom System Image
Release Ny (system-inages;android-33;google_apis; x86_64)
3 API34 %/
1 Jiramisu | Preparing “Install Google APIs Intel x86_64 Atom System Inage API 33 (revision 13)". B
Downloading https://d1.google. con/android/repository/sys-ing/google_apis/x86_64-33_r13.zip
> Sv2 “Install Google APIs Intel x86_64 Atom System Image API 33 (revision 13)" ready.
>men gy Installing Google APIs Intel x86_64 Atom Sys(em Inage in
@ = /Users/HendSam/Library/Andr gle_apis/x86_64
2 R: “Install Google APLs Intel x86_64 Aton System Inage APL 3 (revision 13)" conplete.
H @2 “Install Google APIs Intel x86_64 Atom System Image API 33 (revision 13)" finished.
= pie
2 oreo . the
£ oreo &
8 a .
n
i Done
H O Asystem
2
B | !
Cancel | Previous Next Finish
b Versio.

L) dsomonsarted sucessaly QR TE AT

Myapplicat @ ®

Verify Configuration

Resource Manager

My Application - activity_main.xml [My_Application.app.main]

Virtual Device Configuration

droid Virtual Device (AVD

AVD Name | Pixel 6 API 33

| D piets 6.4.1080x2400 420dpi
>
> () Tiramisu Android 13.0 x86_64
>
> G startup orientation D
2 Portrait Landscape
£ Emulated §
ng] Ear o Graphics:  Automatic
n
Show Advanced Settings
3
=

b Versio,

Change...

Change...

AVD Name
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‘The name of this AVD.,

Cancel
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ANDROID DEVELOPMENT RESOURCES

|
O
\
\
\

\

Our Textbook Forum

o https://forums.bignerdranch.com/

Documentation

o https://developer.android.com/

Newsgroups And Forums

o https://stackoverflow.com/questions/tagged/android

o https://androidforums.com/

Development Tips

o https://android-developers.googleblog.com/

Videos And Tutorials

o https://www.voutube.com/user/androiddevelopers

\



https://forums.bignerdranch.com/
https://developer.android.com/
https://stackoverflow.com/questions/tagged/android
https://androidforums.com/
https://android-developers.googleblog.com/
https://www.youtube.com/user/androiddevelopers

CODE DEMO

- Create a HelloWorld
Android Application
using Android Studio
and walk through the
project content!

o —— -

- = = -




IMPORTANT

Run the HelloWorld
Android App on your
machine and/or VDI
before the end of
the week!




DO YOU HAVE ANY
QUESTIONS?

a hend.alkittawi@utsa.edu
By Appointment
a Online




